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ELEMENTARY MATHEMATICS FOR BIOLOGISTS — 2013 

Task 4 — A Predator–Prey Model 

This session presents a slightly-simplified model of a predator–prey system. An outline 

explanation of the underlying mathematics is given on pages 4.3 and 4.4. It is not necessary 

to delve too deeply into the mathematical details but the result is a good illustration of how a 

spreadsheet can be used to help gain an understanding of a biological process. 

Outline Requirements 

1. Log in to a MCS workstation. 

2. Set up, in the Maths folder, an Excel file PredPrey.xls which contains a single worksheet 

with an embedded chart whose appearance is roughly as shown overleaf. 

3. Arrange for the worksheet to be printed in landscape rather than the portrait default. 

4. Print just the first sheet and show the hard-copy to a demonstrator. 

5. Ask for the Assessed Exercise Taster and work through that. 

Check-List 

The demonstrator will have the following questions in mind when inspecting your work: 

1. Is there a main heading? 

2. Is the worksheet printed in landscape rather than portrait? 

3. Are the numerical values formatted as in the worksheet overleaf? 

4. Have you successfully incorporated the second data series into the chart and arranged to 

have a Secondary axis on the right-hand side? 

5. Have you arranged the legend at the top of the chart? 

6. Is there a footer showing your name and College? 

7. What were the results of the experiments suggested at the end? [Page 4.6] 



Herbivores versus Carnivores – A Prey and Predator Model

Equations:

Let h(y) = number of herbivores in year y

Let c(y) = number of carnivores in year y

h(y+1) = h(y) + b*(hmax-h(y))*h(y) - k*h(y)*c(y)

c(y+1) = q*h(y)*c(y)

where:

hmax = maximum sustainable number of herbivores

b = herbivore birth rate

k = herbivore kill rate

q = efficiency of use of prey

h0 hmax c0 b k q

500 1000 2 0.0005 0.05 0.00205

y h(y) c(y)

0 500.00 2.00

1 575.00 2.05

2 638.25 2.42

3 676.58 3.16

4 679.03 4.39

5 639.12 6.10

6 559.37 8.00

7 458.92 9.17

8 372.63 8.63

9 328.76 6.59

10 330.76 4.44

11 367.97 3.01

12 428.84 2.27

13 502.59 2.00

14 577.39 2.06

. . .

. . .

. . .

50 373.48 2.91
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Task 4 — A Predator–Prey Model 

Synopsis:  The Microsoft Excel Spreadsheet application. Simple mathematical models.   

Briefing 

Mathematical models of biological systems are of enormous importance. At their best, they 

make it possible to conduct elaborate experiments quickly and cheaply and can reduce the 

need for conducting tests on animals. 

Predator–prey models are a good illustration. Many such models have been proposed and 

some of the more elaborate ones convincingly explain observations made in the field. 

In a very simple case where there are unlimited resources and no predators, the prey 

population will grow in much the same way as the bacteria population of problem 4. Even the 

primitive model in the worksheet opposite can readily illustrate the simple case: just set the 

number of carnivores to zero. 

The description of the mathematical model given here begins with the very simple case and 

steadily refines the model. Some suggestions for experimenting with the finished model are 

presented later. 

Note that the population values given in the worksheet are shown to two decimal places. 

Although it makes more sense to show the values as integers (as in the Bacterial Growth 

problem) this has not been done. The justification is that there are periods where the predator 

population changes very slowly so it is useful to see what is going on to the right of the 

decimal point. 

Notation used 

It is unfortunate that both the word predator and the word prey begin with p and to avoid 

confusion the letters h and c are used, standing for herbivore and carnivore. 

Additionally, y stands for the year and h(y) and c(y) are, respectively, the numbers of 

herbivores and carnivores at the start of year y. 

The mathematical model proceeds one year at a time, starting with h0 herbivores and 

c0 carnivores where h0 = 500 and c0 = 2. 

The model assumes a closed environment, such as an island, which can sustain only a limited 

number of herbivores even if there are no carnivores intent on eating them. This limited 

number is hmax. In the worksheet its value is taken as 1000. 

The herbivore population — no carnivores and unlimited resources 

Suppose there are no carnivores and unlimited resources. The increase in the number of 

herbivores during year y is simply proportional to h(y) so that at the start of year y + 1 one 

can say: 

h(y + 1) = h(y) + b.h(y) 

In words: the number at the start of the new year is the number at the start of the old year plus 

some increase. Note that b is some constant representing the birth rate (though, strictly, it 

represents the excess of birth rate over death rate). 
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The herbivore population — no carnivores but limited resources 

With finite resources the relationship has to be modified. The constant b is multiplied by a 

factor (hmax - h(y)) as in: 

h(y + 1) = h(y) + b.(hmax - h(y)).h(y) 

This new factor is positive if the number of herbivores h(y) is less than the sustainable 

maximum hmax and the population grows. If the number of herbivores h(y) is greater than 

hmax the factor is negative and the population shrinks. 

The herbivore population — carnivores introduced 

If carnivores are introduced, the relationship has to be modified further. A quantity has to be 

subtracted to reflect the number of herbivores being eaten. The final relationship is: 

 h(y + 1) = h(y) + b (hmax - h(y))h(y) - kh(y)c(y) (1) 

The number of herbivores killed each year is proportional both to the number of herbivores 

h(y) and to the number of carnivores c(y). Note that k is some constant representing the kill 

rate. 

In words: the number at the start of the new year is the number at the start of the old year plus 

some increase due to births but less some decrease due to killing. 

The carnivore population 

Of course, the number of carnivores changes too. The number of carnivores at the start of 

year y is c(y). The number at the start of year y + 1 is proportional both to the number of 

herbivores available for eating and to the number of carnivores doing the killing. The 

relationship used in the model is: 

 c(y + 1) = q h(y) c(y) (2) 

Note that q is another constant. It is known as the efficiency of use of prey. 

Guided Practical Session 

 Log in to a MCS workstation. 

 Close the Message of the Day window. 

 Start Excel: 

 | All Programs | Spreadsheets Maths and Statistics | Microsoft Excel 2010 

Initialisation 

As in the Bacterial Growth problem, several named cells are used. Three names refer to the 

starting value h0, to the maximum sustainable number of herbivores in the absence of 

carnivores hmax, and to the starting value c0. 

Three other names refer to the constants b, k and q. Look at the worksheet and proceed as 

follows: 

 Key in the introductory text at the head of the worksheet. 

 Key in the six names, right-align them and make them bold. Key the six values, 500, 1000, 

2, 0.0005, 0.05 and 0.00205 into the cells immediately beneath the names. Then use the 
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Create from Selection facility (in the Defined Names group of the Formulas tab) to 

associate the names with the values. 

The main columns 

 Next key in the three headings corresponding to y, h(y) and c(y). Right-align them and 

make them bold. The value y runs from 0 to 50 and the values of h(y) and c(y) are shown 

for the start of each of years 0 to 50. Key in 0 for the initial year and key in =h0 and =c0 
as the initial values for the numbers of herbivores and carnivores respectively. 

 Key appropriate formulae into the three cells underneath the initial values. Assuming the 

headings are in columns A, B and C and in row 17 and that the initial values are in row 

18, the formulae will be: 

=A18+1 

=B18+b*(hmax-B18)*B18-k*B18*C18  from (1) 

=q*B18*C18      from (2) 

 Fill down 50 rows so that the model runs to year 50. Check that the values are as in the 

worksheet on page 4.2. Adjust the formatting to correspond to that used in the 

worksheet. 

The chart 

 Set up an XY (Scatter) chart (of sub-type Scatter with Smooth Lines and Markers) 

which plots h(y) against y. Delete the chart title and label the horizontal axis year. In the 

Plot Area set the Border Color to No line and the Fill to No fill. Ensure that the 

horizontal axis scale runs from 0 to 50. Remove the tick marks from the vertical axis and 

ensure that the labels are shown as integers like 500 and not as 500.00 (in the 

Format Axis dialogue box, click on Number in the left hand column and change the 

number of Decimal places: in the right hand column). 

 Add a second data series for c(y) to the chart. (Click on the Select Data button in the Data 

group on the Design tab, then click the Add button under Legend Entries (Series) to 

bring up the Edit Series dialogue box. Assuming the headings for the model’s data are 

in columns A, B and C of row 17 of worksheet Sheet1, with the data immediately 

beneath, this new series will have a Series name: of =Sheet1!$C$17, 

Series X values: of =Sheet1!$A$18:$A$68, and Series Y values: of 

=Sheet1!$C$18:$C$68.) The new data series will barely rise from the horizontal axis 

because the vertical axis extends from 0 to 800 or so whereas the values in the series 

range from about 2 to 10, so… 

 Right-click the second data series and choose Format Data Series… from the sub-menu 

to bring up the Format Data Series dialogue box. Click on Series Options in the left 

hand column of the dialogue box and choose the Secondary axis option under 

Plot Series On in the right hand column. Click Close. A new axis appears at the right. 

Again ensure that the labels are shown as integers like 5 and not 5.00. 

 Tidy up the chart so that is resembles the one on page 4.2. In particular, move the legend to 

the top of the chart. (Right-click the legend and choose Format Legend… from the 

sub-menu to bring up the Format Legend dialogue box. Click on Legend Options in 

the left hand column of the dialogue box and choose the Top option under 

Legend Position in the right hand column. Click Close.) If necessary, manipulate the 

legend so that the two keys shown are side-by-side rather than one above the other. 
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 Arrange for the chart to fill most of the area occupied by the cells in the range G12 to N36. 

 Study the chart. Note how the numbers of herbivores and carnivores fluctuate. When there 

are very few carnivores, the herbivore population increases. Subject to a delay, this 

results in a growth of the carnivore population but the carnivores eat too many 

herbivores. The result is a drop in the number of herbivores followed by a drop in the 

number of carnivores. 

More tidying-up 

 Select a cell in the worksheet, outside the chart. 

 Click on the word Page Layout at the top of the Ribbon to bring up the Page Layout tab. 

Click the small arrow ( ) in the lower right corner of the Page Setup group: 

 
…to bring up the Page Setup tab dialogue box and set up the whole page ready for 

printing. As usual, check via Print the Backstage view that the overall appearance is 

satisfactory. This should be as on page 4.2. To arrange for the worksheet to be printed in 

landscape you will need to use the Page tab of the Page Setup tab dialogue box. 

Some experiments 

 Set c0 = 0 so there are no carnivores. Note how the number of herbivores rises to 1000 and 

stays constant. 

 Set h0 = 1200 so there are more herbivores than can be sustained. Note how the number of 

herbivores falls to 1000 and stays constant. 

 Restore the original values of h0 and c0. Try modifying b, k and q. Note that the model can 

be very sensitive to small changes in one of these constants but that it is less sensitive to 

changes in the other two. 

 Can you find values which lead to extinction? 

 What are the principal inadequacies of this model? 
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